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Skrutky so Sesthrannou hlavou - Hexagon Head Screws - Sechskantschrauben

DIN 558

STN 02-1303
IS0 4018

Y

Hrubé skrutky so Sesthrannou hlavou a zavitom k hlave
Hexagon Head Screws
» Sechskantschrauben mit Gewinde bis Kopf
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DIN 561
STN 02-1115

Y

Odtlacovacie skrutky so Sesthrannou hlavou s ¢apikom
Hexagon Head Set Screws with small Hexagon and Dog Point
Sechskantschrauben mit Zapfen und kleinem Sechskant

¥y Y

DIN 564
STN 02-1116

Odtlacovacie skrutky so Sesthrannou hlavou s hrotom
Hexagon set screws with half point and cone end
» Sechskantschrauben mit ansatzspitze und auslauf
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DIN 601

STN 02-1301
ISO 4016

¥

Hrubé skrutky so Sesthrannou hlavou a zavitom k hlave
Hexagon Head Screws
» Sechskantschrauben mit Gewinde bis Kopf
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DIN 609
STN 02-1111

Licované skrutky so Sesthr. hlavou s dlhym zavitom
Hexagon Fits Bolts with Long Thread
» Sechskant-PaBschrauben mit langem Gewindezapfen
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Skrutky so Sesthrannou hlavou - Hexagon Head Screws - Sechskantschrauben

D| N 6 ] 0 » Licované skrutky so Sesthr. hlavou s kratkym zavitom
» Hexagon Fits Bolts with Short Thread
STN 02-1112 » Sechskant-PaBBschrauben mit kurzem Gewindezapfen
t': - b - O T
Xy L > - 3 -
Dl N 93 '| » Presné skrutky so Sesthrannou hlavou
» Hexagon Head Bolts
STN 02-1101 » Sechskantschrauben
ISO 4014
I - b ... O ]
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DIN 9233 » Presné skrutky so $esthrannou hlavou a zdvitom k hlave
» Hexagon Head Bolts
STN 02-1103 » Sechskantschrauben mit Gewinde bis Kopf
ISO 4017
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DIN 960 » Skrutky so Sesthrannou hlavou s jemnym zavitom
» Hexagon Head Bolts - Metric Fine Pitch Thread
STN 02-1101 » Sechskantschrauben mit Schaft - Feingewinde
18O 8765
- o l - . v
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DlN 96 '| > Skrutky so Sesthrannou hlavou s jemnym zavitom k hlave
» Hexagon Head Bolts - Metric Fine Pitch Thread
STN 02-1103 » Sechskantschrauben mit Schaft - Feingewinde
ISO 8676
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Skrutky so Sesthrannou hlavou - Hexagon Head Screws - Sechskantschrauben

Yy

DIN 69 14 Skrutky so Sesthrannou velkou hlavou HV
High-Strength Structural Bolts
ISO 7412 » HV Sechkantschrauben
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D| N 7 990 » Skrutky so Sesthrannou hlavou pre ocefové konstrukcie
» Hexagon Head Bolts with oversized Thread
STN 1308 » Sechskantschrauben mit UbermaBgewinde
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Vruty a skrutky do plechu - Wood Screws and Self-Drilling Screws
- Holzschrauben und Blechschrauben

U Ni Vruf ZH » Univerzélny vrut so zapustenou hlavou a krizovou drazkou
» Chipboard screws countersunk head
» Universalschrauben senkkopf

Uni vrut PH » Univerzélny vrut s pologulatou hlavou a krizovou drazkou
» Chipboard screws pan head
» Universalschrauben halbrundkopf

Uni vrut ZH Torx > Univerzélny vrut so zapustenou hlavou Torx
> Chipboard scews Torx head

> Universalschrauben Torx kopf

VI'Ut scd ro ko rfén » Skrutka sddrokartén zapustend hlava
» Drywall screw

» Schnellbauschrauben

D| N 7 50 4 K » Samovrtnd skrutka so Sesthrannou hlavou
» Self-Drilling Hexagon Head Screws with Collar
» Sechskantbohrschrauben mit Bund
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Vruty a skrutky do plechu - Wood Screws and Self-Drilling Screws
- Holzschrauben und Blechschrauben

D|N 7 50 4 N » Samovrtna skrutka s valcovou hlavou a krizovou drazkou
» Self-Drilling Cross Recessed Pan Head Screws
» Linsen-Bohrschrauben mit Kreuzschlitz

$ P

Dl N 7 50 4 P » Samovrtnd skrutka so zapustenou hlavou a kriZovou drazkou
> Self-Drilling Cross Recessed Countersunk Head Screws
» Senkbohrschrauben mit Kreuzschlitz

Samovrtna skrutka s vnutornym Stvorhranom
Dl N 7 504 SQ : Self-Drilling Pan head SQ
» Bohrschrauben SQ

D| N 7 50 4 F L » Samovrtna skrutka s okrasnou hlavou a nalisovanou podlozkou
» Self-Drilling Wafer head, cross-recessed H
» Bohrschrauben mit Flanschkopf

D'N 9 5 > Skrutky do dreva so zapustenou hlavou SoSovkovitou
» Slotted Raised Countersunk (oval) Head Wood Screws
» Linsensenk-Holzschrauben mit Schlitz
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Vruty a skrutky do plechu - Wood Screws and Self-Drilling Screws
- Holzschrauben und Blechschrauben

D| N 96 » Skrutky do dreva s pologulatou hlavou
» Slotted Round Head Wood Screws
STN 02-1812 » Halbrund-Holzschrauben mit Schlitz
ke L - - L .
D| N 9 7 » Skrutky do dreva so zapustenou hlavou
» Slotted Countersunk (flat) Head Wood Screws with Hole
STN 02-1814 » Senk-Holzschrauben mit Schlitz und Bohrung
b L - - g >
DIN 571 » Skrutky do dreva so Sesthrannou hlavou

» Hexagon Head Wood Screws
STN 02-1814 » Sechskant-Holzschrauben

¥
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DIN 79 7 1 C » Skrutky do plechu s valcovou hlavou

» Pan head, slotted self tapping screws
STN 02-1232 » Zylinder Blechschrauben mit Schlitz
ISO 1481
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DIN 79 7 2 » Skrutky do plechu so zapustenou hlavou
» Slotted Countersunk Head Tapping Screws
STN 02-1236 » Senk Blechschrauben mit Schlitz
18O 1482
S _Eesssassaan,
Fraaveeesy”
- u‘ L

6



BestBolt

www.bestbolt.eu

Vruty a skrutky do plechu - Wood Screws and Self-Drilling Screws
- Holzschrauben und Blechschrauben

D| N 7 9 7 3 » Skrutky do plechu so zapustnou hlavou SoSovkovitou
» Slotted Raised Countersunk Head Tapping Screws

STN 1238 » Linsensenk-Blechschrauben mit Schlitz

ISO 1483

D| N 7 Q 8 '| » Skrutky do plechu s polog. hlavou a s krizovou drazkou
» Cross Recessed Pan Head Tapping Screws

STN 02-1235 » Linsen-Blechschrauben mit Kreuzschlitz

ISO 7049
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DIN 7982 » Skrutky do plechu so zdp.hlavou a s kriZzovou drdzkou
» Cross Recessed Countersunk Head Tapping Screws

STN 02-1237 » Senk-Blechschrauben mit Kreuzschlitz

ISO 7050

DIN 79 8 3 » Skrutky do plechu so zdp.hlavou $oSov. a s krizovou drazkou
» Cross Recessed Oval Head Tapping Screws

STN 02-1239 » Linsensenk-Blechschrauben mit Kreuzschlitz

ISO 7051
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Ostatné skrutky - Other screws - Andere schrauben

D| N '] 480 » Napinace s liatinovymi maticami O—H, H—H, O- 0
Turnbuckles
STN 02 -1940 » SpannschloBmuttern
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D| N ] 5 2 3 7 » Korcekové skrutky zapustné
» Seating Screws
STN 02 -1329 » Tellerschrauben
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DIN 186 » Skrutky s hlavou T a Stvorhranom
» T-Head Bolts with Square Neck
STN 02-1343 » Hammerschrauben mit Vierkantansatz
) J & bk
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DIN 2 6 1 » Skrutky s hlavou T
» T-Head Bolts
STN 02-1341 » Hammerschrauben
- L -
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D'N 3] 6 » Kridlové skrutky
» Wing Screws
STN 02-1365 » Fliigelschrauben
1
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Ostatné skrutky - Other screws - Andere schrauben

DIN 404 » Skrutky s valcovou hlavou a otvormi v hlave
» Recessed Cross Holed Head Screws
STN 02-1128 » Kreuzlochschrauben und Schlitz
@) "
) X @
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D|N 4 '| 7 » Nastavovacie skrutky so zdarezom a éipkom
» Slotted Set Screws with Dog Point
STN 02-1185 » Gewindestift mit Schlitz und Zapfen
ISO 7435
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DIN 444 » Presné otocné skrutky s okom
» Eye Bolts
STN 02-1167 » Augenschrauben
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DIN 464 » Skrutky s vysokou ryhovanou hlavou
» Knurled Thumb Screws
STN 02-1161 » Rindelschrauben - hohe Form

DIN 478 Upinacie skrutky s ndkruzkom
Square head bolts with collar
STN 02-1122 » Vierkantschrauben mit bund
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Ostatné skrutky - Other screws - Andere schrauben

DIN 479
STN 02-1121

» Upinacie skrutky s osadenym koncom
» Square Head Bolts with Short Dog Point
» Vierkantschrauben mit Kernansatz
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DIN 551

STN 02-1181
ISO 4766

» Nastavovacie skrutky so zdrezom a plochym koncom
» Slotted Set Screws with Flat Point
» Gewindestift mit Schlitz und Kegelkuppe

Z

] B o bbb b b ey
-

- T

DIN 553

STN 02-1185
15O 7434

» Nastavovacie skrutky so zarezom a hrotom
» Slotted Ser Screws with Cone Point
» Gewindestifte mit Schlitz und Spitze

=

DIN 580

STN 02-1369
IO 3266

» Zavesné skrutky
» Lifting Eye Bolts
» Ringsschrauben

DIN 603

STN 02-1319
ISO 8677

» Skrutky s plochou gulatou hlavou a stvorhranom
» Cup Head Square Neck Bolts
» Flachrundschrauben mit Vierkantansatz
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Ostatné skrutky - Other screws - Andere schrauben

Zapustné skrutky s nosom do kovu

Flat Countersunk Square Neck Bolts with long Square

Zapustné skrutky so Stvorhranom do dreva
Flat Countersunk Square Neck Bolts
» Senkschrauben mit hohem Vierkantansatz

» Zapustné skrutky so Stvorhranom do kovu
Flat Countersunk Square Neck Bolts with short Square
» Senkschrauben mit niedrigem Vierkantansaiz

PaBRschrauben mit langem Gewindezapfen

DIN 604 : Flat Countersunk Nib Bolts
STN 02-1324
i S T

DIN 605
STN 02-1327
DIN 608
STN 02-1326

» Li 3 skrutky s dlhy vit
DIN 609 ~ Hexagon Fit Bolts with long thread
SIN02-1111 >

> Li 3 skrutky s kra Vit
DIN 610 . Hexagon Fit Bolte with sort thread
STN 021112

» PaBschrauben mit kurzem Gewindezapfen

-
Y
N i .‘
S, v
h '
e >

1



BestBolt

www.bestbolt.eu

Ostatné skrutky - Other screws - Andere schrauben

DIN 6 53 » Skrutky s nizkou ryhovanou hlavou
» Knurled Thumb Screws - Thin Type
STN 02-1162 » Ré&ndelschrauben - niedrige Form

Ly

DIN 69] 2 » Skrutky s inbusovou nizkou hlavou
Low Head Socket Cap Screw
» Zylinderschrauben mit Innensechskant und niedrigem Kopf

» Skrutky s inbusovou polgulatou hlavou
Socket Button Screw
» Linsenschrauben mit innensechskant

DIN 7984 » Skrutky s vnutornym Sesthrannom a nizkou hlavou
Hexagon Socket Head Cap Screws with Low Head
» Zylinderschrauben mit Innensechskant und niedrigem Kopf

DIN 79 8 5 » Skrutka s valcovou polgulatou hlavou a krizovou drazkou
Cross Recessed Pan Head Machine Screws

STN 02-1147 » Linsenkopf Gewindeschrauben mit Kreuzschlitz

ISO 7045
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Ostatné skrutky - Other screws - Andere schrauben

Skrutky so zapustnou hlavou s vnutornym Sesthranom

|
Dl N 7 99 ] » Hexagon socket countersunk head screws
ISO 10642 » Senkschrauben mit innensechskant
: ~= [
) A ] L Al
/ - L ‘- I
SLE L - - 4, -
D| N 8 3 5 » Zavrtné skrutky do zliatin hlinika (e = 2d )
» Studs - Metal End = 2d
STN 02-1178 » Stiftschrauben - Einschraublinge 2d
- h > L
- L « 4 .
DIN 84 » Skrutky s valcovou hlavou
» Slotted Cheese Head Screws
STN 02-1131 » Zylinderschrauben mit Schlitz
ISO 1207
- C SRR
P T L - - d >
DIN 8 5 » Skrutky s velkou valcovou hlavou
» Slotted Pan Head Screws
STN 02-1137 » Flachkopfschrauben mit Schlitz
ISO 1580
9 C ARy v orecsose v arenra v
ko L - - g, -
DlN 8 6 > Skrutky s pologulatou hlavou
» Slotted Round Head Screws
STN 02-1146 » Halbrund-Schrauben mit Schlitz
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Ostatné skrutky - Other screws - Andere schrauben

DIN 910

» Zatky s nakruzkom
» Hexagon Head Screw Plugs
» VerschluBschrauben mit Bund

DIN 212

STN 1143
ISO 4762
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» Skrutky s valcovou hlavou a vnutornym Sesthranom
» Hexagon Socket Head Cap Screws
» Zylinderschrauben mit Innensechskant

FRYINVITHRASRIRAN

DIN 213

STN 02-1187
ISO 4026
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» Nastavovacie skrutky s vnutor.sesthran.a kuzel.koncom
» Hexagon Socket Set Screws with Flat Point
» Gewindestift mit Innensechskant und Kegelkuppe

O ———

e

DIN 914

STN 02-1191
SO 4027

» Nastavovacie skrutky s vnutornym Sesthr. a hrotom
Hexagon Socket Set Screws with Cone Point
» Gewindestift mit Innensechskant und Spitze

DIN 215

STN 02-1189
IO 4028

» Nastavovacie skrutky s vnutornym Sesthr. a ¢ipkom
» Hexagon Socket Set Screws with Dog Point
» Gewindestift mit Innensechskant und Zapfen

14
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Ostatné skrutky - Other screws - Andere schrauben

D| N 9 '| 6 » Nastavovacie skrutky s vnutor. Sesthr. a kuZel. jamkou
» Hexagon Socket Screws with Cup Point
ISO 4029 » Gewindestift mit Innensechskant und Ringschneide

» Zavritné skrutky do ocele (e = 1d)
Dl N 93 8 » Studs - Metal End = 1d
STN 02-1174 » Stiftschrauben - Einschraubende = 1d

» Zdvriné skrutky do liatiny (e = 1,25d )
DI N 9 39 » Studs - Metal End = 1,25d
SIN 02-1176 » Stiftschrauben - Einschraubende = 1,25d

D| N 963 » Skrutky so zdpustnou hlavou
» Slotted Countersunk Head Screws

STN 02-1151 » Senkschrauben mit Schlitz

ISO 2009

| i {

fadesle L o B d, o

DIN 964 » Skrutky so zdpustnou hlavou $oSovkovitou
» Slotted Raised Countersunk Head Screws

STN 02-1155 » Linsen-Senkschrauben mit Schlitz

ISO 2010
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Ostatné skrutky - Other screws - Andere schrauben

DIN 9265

STN 02-1152
ISO 7046

7

b

» Skrutky so zdapustnou hlavou a krizovou drdazkou
» Cross Recessed Countersunk Head Screws
» Senkschrauben mit Kreuzschlitz

o RN

DIN 9266

STN 02-1156
SO 7047
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» Skrutky so zapustnou hlavou Sosov.a krizovou drazkou
» Cross Recessed Raised Countersunk Head Screws
» Linsen-Senkschrauben mit Kreuzschlitz

x .'l:‘
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DIN 967

.

» Okrasné skrutky
» Cross Recessed Pan Head Screws with Collar
» Linsenkopf Schrauben mit Bund

16
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Matice - Nuts - Muttern

DIN 1478
STN 1682

d,
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» Matice pre napinace
Turnbuckle nuts
» Spannschlobmutter

* e e e

» Matice uzatvorené
DlN ] 58 7 » Hexagon Domed Cap Nuts
Sechskant-Hutmuttern, Hohe Form
! }
4 | “J
- h - - »
» Kridlové matice
DIN 315 i
STN 1665 » Fliigelmuttern

Matice
podlozky

DIN 439

STN 02-1403
ISO 4036

» Presné Sesthranné matice nizke
» Hexagon Thin Nuts
» Sechskantmuttern, niedrig
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Matice - Nuts - Muttern

» Ryhované matice
DIN 466 » Knurled Thumb Nuts - high type
STN 02-1461 » Réndelschrauben - hohe Form
D| N 46 7 » Ryhované matice nizke

» Knurled Thumb Nuts - thin type
STN 02-1462 » Rindelschrauben - niedrige Form
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» Matice pre T - draZky
Nuts for T-Slots
» Muttern fiir T-Nuten

Y

. 4

D|N 546 » Valcové matice so zarezom
» Slotted Round Nuts
STN 02-1444 » Schlitzmuttern
> l -
7
vz
D{yN 555 » Hrubé sesthranné matice
> Hexagon Nuts
STN 02-1601 » Sechskantmuttern
ISO 4034
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Matice - Nuts - Muttern

» Matica Sesthrannd vysoka 1,5 d s nakruzkom

DIN 557 » Stvorhranné matice
» Square Nuts
STN 02-1624 » Vierkantmuttern
» Drobné Stvorhranné matice nizke
D|N 562 » Square Thin Nuts
STN 02-1416 » Vierkantmuttern, niedrig
“v \C/
» Matice zdvesné
Dl N 58 2 » Lifting Eye Nuts
ISO 02-1669 » Ringmuttern
14 C@ e
- L -
» Matica Sesthrannd vysoka 1,5 d
DIN 6330 » Hexagon Nuts 1,5d
» Sechskantmuttern 1,5d hoch
[ il
2 |
DIN 6331

» Hexagon Nuts 1,5d with Collar
» Sechskantmuttern 1,5d hoch mit Bund
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Matice - Nuts - Muttern

DlN 63 34 » PredlZovacie matice

Hexagon nuts height 3d
STN 02-1604 » Sechskantmuttern 3d hoch

| |

« L » -

o
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DlN 69] 5 » Konstrukéné matice Sesthranné
» Heavy Series Hex Nuts
ISO 7414 » Sechskantmuttern HV Verbindungen

Dl N 692 3 » Ozubené matice s limcom
»>

Hex Flange Nuts
» Sechskantmuttern mit Flansch

DlN 6924 » Samoistna matica vysoka

» Prevailing Torque Hexagon Nuts
» Sechskantmuttern mit Klemmteil

Poistné matice Sesthranné plechové
Dl N 796 7 : Self-locking Counter Nuts
» Palmuttern

M
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Matice - Nuts - Muttern

D|N 9] 7 » Uzavreté matice
»>

Hexagon Cap Nut
STN 02-1431 » Sechskant-Hutmuttern, niedrige Form

DIN 928 » Stvorhranné matice na privaranie
Square Weld Nut
Vierkant-Schweilmuttern

« Moy

DlN 929 » Sesthranné matice na privéranie
» Hexagon Weld Nut
ISO 02-1455 » Sechskant-Schweiimuttern

Dl N 934 » Presné sesthranné matice
» Hexagon Nuts

STN 02-1401 » Sechskantmuttern

ISO 4032

DIN 935 » Korunkové matice

» Hexagon Slotted and Castle Nut
STN 02-1411 » Kronenmuttern

ISO 7035
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Matice - Nuts - Muttern

DIN 936

STN 02-1403
IS0 4035

» Presné sesthranné matice nizke
» Hexagon Nuts small Type
» Sechskantmuttern niedrige Form

S
]

DIN 937

STN 02-1412
ISO 7038
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Korunkové matice nizke
Hexagon Slotted and Castle Nut -small Type
» Kronnenmuttern - niedrige Form

b A |

DIN 979

STN 02-1412
IO 7038
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» Korunkové matice nizke
Hexagon Thin Castle Nuts
Kronenmuttern niedrige Form

0, 4

DIN 980

STN 02-1442
IS0 7042

» Samozaistovacie matice Sesthranné celokovové
» Prev.Torque Type Hex.Nuts - All Metal
» Sechskantmuttern mit Klemmteil - Ganz Metall

DIN 982

STN 02-1492
ISO 7040

Samozaist'ovacie matice Sesthranné
Prev.Torque Type Hex.Nuts - with Plastic Insert - High Type
» Sechskant-Sicherungsmuttern mit Nylonring-hohe Form

Y v
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Matice - Nuts - Muttern

DIN 985

STN 02-1492
15O 10511

« o

» Samozaistovacie matice Sesthranné nizke
» Prev.Torque Type Hex.Nuts - with Plastic Insert
» Sechskant-Sicherungsmuttern mit Nylonring

DIN 986

» Poistna matica klobukova

Self Locking Domed Cap Nuts With Nylon Insert
» Sicherungshutmuttern

23
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PodloZky - Washers - Scheiben

» Federringe glatt mit Rechteckigem Querschnitt

DIN 125
STN 02-1702
ISO 7089
i ‘s - g, L3
DIN 1 26 » Hrubé podlozky
» Plain Washers
STN 02-1724 » Flache Scheiben
ISO 7091
»a® L 4
DIN '| 2 7 » Podlozky pruzné s obdlznikovym prierezom
» Spring Lock Washers with Square Ends
-lhh-
% ‘ — 1;
> ad L &
» Podlozky pruZné zvinené
DIN ] 28 » Curved Spring Lock Washers
» Federringe gewdibt
L -!h
-t L o J
Dl N ] 3 7 » Pruzné podlozky prehnuté

» Curved Spring Washers
» Federscheiben, gewolbt
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PodloZky - Washers - Scheiben

» Podlozky pre trecie spoje
DIN ] 440 Flat Washers for Clevis Pins
STN 02-1706 » Flache Scheiben fiir Bolzen
I1SO 8738
> a3 ! . J o
» Podlozky pre kruhové capy
DlN 1 44] Flat Washers for Clevis Pins
STN 02-1706 » Flache Scheiben fiir Bolzen
»ad ] | O
STN 02-1729 » Podlozky pre konstrukcie z tvrdého dreva

» Washer for Hard Wood Construstions
» Hart Holz Bau Scheiben

. 90

»ad

DIN 2093 » Vyduté podiozky

» Disc Springs
» Tellerfedern

DIN 43 2 » Poistné krazky s nosom
» Washers with External Tap
SIN 02-1753 » Scheiben mit Aussennase
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PodloZky - Washers - Scheiben

DIN 433 » Podlozky pre skrutky s valcovou hlavou a pologulatou hlavou
» Plain Washers for Cheese Head Screws

STN 02-1703 » Flache Scheiben fiir Zylinderschrauben

ISO 7092

- a¥ L i J o
Podlozky pre drevené konsStrukcie

DiN 440R Washers for Wood Constructions
STN 02-1727 » Scheiben fiir Holzkonstruktionen

SO 7094
4 -

YV

>t

Y

Poistna podlozZka s dvomi jazyékami
Tab Washers with long tab and wing
Scheiben mit zwei Lappen

- b »
i i
- )
L ¢ ¥
< B,

DIN 463

Yy v

DlN 63] 9C » Konvexné podlozZky

» Spherical washers
» Kugelscheiben

» Konkdvne podlozky
» Conical Seats
» Kegelpfannen
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PodloZzky - Washers - Scheiben

DIN 6340

>t

PodloZky pre vysokopevnostné spoje
Plain Washers, hardened
» Scheiben fiir Spannzeuge, gehértet

i
&3
L
- L >

Yy v

DIN 6796

Y

Podlozky napinacie
Conical Spring Washers
Spannscheiben

i
=
T
- L -

Y v

DIN 6797 A
STN 02-1744

» Ozubené podloZky
» Toothed Lock Washers Internal Teeth
» Zahnscheiben, Innengezahnt

DIN 6797 J
STN 02-1744

» Ozubené podloZky
» Toothed Lock Washers Internal Teeth
» Zahnscheiben, Innengezahnt

D Q

DIN 6798

» Vejadrovité podlozky s vnutornym ozubenim
» Serrated Lock Washers Internal Teeth
» Facherscheiben, Innengezaht
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PodloZzky - Washers - Scheiben

D| N 69 '| 6 » Podlozky pre vysokopevnostné konstrukcie
» Structural Flat Washers
ISO 7416 » Scheiben fiir HV Verbindungen

X

DIN 6918 Podlozky pre U profily
Square Taper Washers for Channels
STN 02-1739 » Vierkantscheiben

»N

A

Kruhové podloZky pre ocel'ové konstrukcie
Washers for Bolts with Heavy Type Spring Pins
Scheiben fiir Schrauben mit Schweren Spannhiilsen

h 4

DIN 7349
STN 02-1708

¥y v

-t

Podlozky pruzné so Stvorcovym prierezom
Spring Washers
Federscheiben

DIN 7980
STN 02-1740

Y, YN

L

_—

DIN 7989 » Kruhové podloZky pre ocelové konstrukcie
» Washers for Steel Constructions
STN 02-1708 » Scheiben fiir Stahlkonstruktionen

<%
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www.bestbolt.eu

PodloZky - Washers - Scheiben

DIN 90 2 1 » Podlozky pod nity
» Plain Washers d2=3xd1
STN 02-1726 » Flache Scheiben d2=3xd1
ISO 7093
ot i & | o
DIN 9 3 » Podlozky poistné s jazy¢kom
» Tab Washers with Long Tab
STN 02-1751 » Scheiben mit Lappen
- b -
Dl N 98 8 » Vymedzovacie podlozky
» Shim Rings and Supporting Rings
» PaBscheiben und Stiitzscheiben
Korosé rske » Karosdrska podlozka
» Mudgard washers
» Karosseriescheiben
G “ S -
MQ ssoge » Podlozky Massage

» Massage Washers
» Massage Scheiben

{ (@

29
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PodloZzky - Washers - Scheiben

s Nord Lock
Nord Lock » Nord Lock

» Nord Lock

» podlozka s gumou EPDM
E PDM » EPDM bounded washer
» Scheiben mit EPDM

R|pp LOCk » Ripp Lock

» Ripp Lock
» Ripp Lock

%

% //? NN
e d M

Schnorr » Schnorr

» Schnorr
» Schnorr

» ol

> Starlock
Starlock (e

» Starlock

T
A
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BestBolt

www.bestbolt.eu

Bez zavitu - Without thread - Ohne Gewinde

DIN 1

STN 02-2150
SO 2338

KuzZel'ové koliky

Taper pin

Kegelstift
(__
T — et ey

DIN 11 023 » Zakolnik
» Linch Pin
» Klappsplinte
- d‘ .
DIN 11 024 » Zavlacka pruznd jednoduchd
» Spring Cotters single coil
» Federstecker Form E
QY
- L L
» Zavlacka pruzna dvojitad
DIN 1 ] 024 » Spring Cotters double coil
» Federstecker Form D
% |
L L "
DIN 14 36 » Capy s hlavou a medznymi odchylkami priemeru h 11
» Clevis pins with big head
STN 02-2109 > Bolzen mit groBem kopf

32
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Bez zavitu - Without thread - Ohne Gewinde

DIN 1444 » Capy s hlavou a medz.odchyl.h11a otvorom pre zdvlacku
» Clevis pins with head
STN 02-2111 » Bolzen mit kopf
ISO 2341
Ol|l=
- L HL)
» Pruzné koliky
DIN ] 48 1 » Spring-Type Straight Pins
STN 02-2156 » Spannstifte (Spannhiilsen)
ISO 87562

— [ C
E" ________ v i

D|N 4 7 1 » Poistné krizky pre hriadel
» Retaining Rings for Schafts
STN 02-2930 » Sicherungsringe fiir Wellen
'i < i' o ‘ ’
> ol ¥
DIN 47 2 » Poistné kruzky pre dieru
» Retaining Rings for Bores
STN 02-2931 Sicherungsringe fiir Bohrungen
> 1t
DIN 6325 » Valcové koliky kalené
» Dowel Pin - Hardened
STN 02-2152 » Zylinderstifte - gehiirtet
ISO 8734

G =

33
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Bez zavitu - Without thread - Ohne Gewinde

» Nity s pologul'atou hlavou
DI N 660 » Round Head Rivets
STN 02-2301 » Halbrundniete
ISO 10561
LKL, L
» Zdpustné nity
DI N 66 ] Countersunk Head Rivets
STN 02-2311 » Senkniete
ISO 1051
aFiy L - - d. -
DIN 67 Q9 » Poistné strmeriové kruzky

STN 02-2929

» Retaining Washers for Shafts
Sicherungsscheiben (Haltescheiben) fiir Wellen

DIN 6885A

Pera tesné
Parallel Keys
PaBfedern

Y Yy

DIN 6888

» Pera Woodruffové
Woodruff Keys
» Scheibenfedern
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Bez zavitu - Without thread - Ohne Gewinde

D|N 7 » Valcové koliky

» Dowel pin
STN 02-2150 > Zylinderstift
ISO 2338

&
1 =

Dl N 7 3 3 7 » Trhacie nity

» Blind Rivets
STN 02-2391 » Blindniete
1ISO 15973

A
'y
o 111 -] H—m
¥ S5, /////g

¥

- L ke

Nity s plochou hlavou
Dl N 7 3 3 8 : Flat Head Rivets
STN 02-2330 » Flachkopfniete
Ky o L >
DlN 7603 » Tesniaci kriazZok
» Sealing rings

Dichtringe fur Verschlussschrauben

; .
O i
t A L
- _'S ~
- d. »

Y

D‘N 79 7 8 » KuZel'ové koliky s vnutornym zdvitom
» Conical Pins with inside Thread
STN 02-2150 » Kegelstift mit Innengewinde
IS0 8736
LT ([/%\ D
Wi ssssssss b iis? E

a
£ b l’ e
- ;
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Bez zavitu - Without thread - Ohne Gewinde
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DIN 741
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FIXING INNOVATION

Gl nylonova univerzélna hmozdinka

l BCS 12/120 14x72 [ HTVEO7 10x80
~———————— | ges1145  14x72 | HTVEOS 10x100
“ : BCS 14/120 14x72 I HTVEOD9 10x115
Oznatenie Rozmer | BCS 14/145 14x72 | HTVE10 10x135
GLS 525 | BCS 14/170 14x72 | HTVEL1 10x160
GL6 6x30 | : : GX-L konitrukéna MULTI hmozdink
lechové rozperna kotva | onstrukena m @
GL8 8x40 | BGp P I so zapustnou skrutkou Pz
b sl | of | G —
GL12 12x60 - ¢ _
GL14 14x70 I I o sene -l
. Oznacenie Rozmer
CONDOR nylonové hmozdinkado | O:‘;éee:'e R‘;z“;:’ | GXL660V 6x60
plnych materiaalov I HT 84 8:40 | GXL880OV 8x80
I LT x40 I GXL8100V 8x100
! = GXL8120V 8x120
: | NYLCASA nylonova rozperna | —— e
Oznacenie Rozmer | hmozdinka |
coa 4x20 | ,- | GX-L konstrukéna MULTI hmozdinka
CO05 5x25 I Sy | so zapustnou skrutkou Torx.
co6 6x30 | ' | *aj so skrutkou A4
o8 8x40 | Baniiania fo— | T ETT T ETT VI SSS S —
€10 10x50 HTE94 9x40 e e a ]
c12 12x60 | L S == -
cia 14x80 I CONDOR CORNICE konstrukéna hmozdinka I Oznacenie Rozmer
C14A100 00 | e gy | 1 exuesovT 8x80
| g ] GXL8100VT 8x100
’ % % e mmsma e e —
L'UNIVERSALE nylonové uzlovacia | ~ GXL8120VT 8x120
hmozdinka | . | GXP8140VT 8x140
Rttt A —
— - I Oznacenie Rozmer I GXL10100VT 10x100 &
| HTVO1 6X60 | GXL10120VT 10x120 *
Oznaéenie Rozmer | HTVO15 8x60 | GXL10140VT 10x140 *
HNUO6 6x35 | HTVO2 8x80 | GXL10160VT 10x160 *
HNU0S0 1‘;"2?) | HTVO3 8x100 | GXL10200VT  10x200
HiNLY X | HTVO4 8x120 | o N
GBU nylonova hmozdinka do | HTVOS 10x65 | GX-L konstru¢na MULTI hmoZdinka
utych priestorov | T 80 | so 6hr skrutkou
X . PRI
e e | HTVO8 tox00 |
- | HTVO09 10x115 | = ~-—
Oznacenie Rozmer I eREVELE) AOx135 I Oznacenie Rozmer
\ | ne|
GBUG 6x40 | WL 460 | GXL1080VE 10x80
GBUS 8x30 | CONDOR CORNICE konstruking hmozdinka | GXL10100VE 10x100
t : :
SBHID, 40360 | 26na-dobetonuapinjchmaterislov |~ GXL10120VE  10x120
BCShmozdinkasocefovym | sl | GXL10140VE 10x140
drziakom | _ | GXL10160VE 10x160
L e —— I m I GXL10200VE 10x200
Oznacenie Rozmer | Oznacenie Rozmer | GXL10240VE 10x240
BCS 8/70 12x58 | HTVEO15 8x60 | GXL10260VE 10x260
BCS 10/100 12x72 | HTVED2 8x80 |
BCS 10/150 12x72 I HTVEO3 8x100 I
BCS 12/100 14x72 ! HTVEO4 8x120 !
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FIXING INNOVATION

Hmozdinka/Kotva

GX-L konstruéna MULTI hmoZdinka LATER CORNICE konétrukéna hmozdinka

LATER CORNICE konstrukéna hmozdinka

s dlhou exp zénou so zapustnou skrutkou TURBO JET Zatlkacia hmoZdinka

s kombinovanou skrutkou 6hr/T40 |  sdihou exp zénouso 6hr skrutkou ! T18-100V 8x100 *
| | TJ8-120V 8x120
- e _i | W X | INFISSO Nylonové
Onatatie Reger | o 2= | konstrukéna kotva
GXL10BOVEFT 10480 | _Oatenie Rommer | e —)
GXL10100VEFT 10x100 | cioasoLuve 10x80 | . !
GXL10120VEFT 10x120 | cl0A100LUVE 1ox00 | —Cfacene S
GXL10140VEFT 10x140 | C10A120LUVE 10x120 | K8C100 5:105
GXL10160VEFT 10x160 .
I Ci"“igotﬂ\‘ﬁ ig"”o I K8c120 5x125
C10A160 x160
LATER CORNICE konstrukéna hmozdinka | C10A200LUVE 10x200 | BEC1A SkdS
s dlhou exp zénou bez skrutky | - | K10C80 BXES
C12A160LUVE 12x160 K10C100 6x150
SRS . | C12A200LUVE 12x200 | K10C120 6x125
I T I C12A240LUVE 12x240 I — —
C10A80LU 10x80 | TURBO JET Zat[kacia hmozdinka | K10C165 6x165
C10A100LU 10x100 | SO Za’pustnym limcom |
Kotv
oo o | e | NerTOt
Comeoy a0 | Cmatene  Remer | o))
| Ti5-275V 5x27 | R
LATER CORNICE konstrukéna hmozdinka TJ5-37SV 5x37 Oznacenie Rozmer
s dlhou exp zénou so zapustnou skrutkou Pz I TI5-47SV 5x47 I L4-46/1 M4x46
-~ — T16-325V 6x32 L5-46/1 M5X46
_ I TJ6-405V 6x40 I L5-57/1 M5x57
SCaea 3 TJ6-555V 6X55 L6-57/1 M6xX57
: | | L6-70/1 M6x70
Oznatenie Rozmer | Te-675V 6x67 |
C10A80LUV 10x80 | 136:8050 6x30 | SITA - Stropna kotva
C10A100LUV 10x100 | TJ8-455V 8x45 | -
C10A120LUV 10x120 | TJ8-60SV 8x60 | H
C10A160LUV 10x160 | TJ8-100SV 8x100 | S06 6x60
C10A200LUV 10x200 | TJ8-1205V 8x120 | RAPID NYLON Nylonova
| TJ8-1355V 8x135 | hmozdinka do sadrokarténu
Torx. * aj so skrutkou A4 a I s rovnym limcom* aj s Iflincom A2 I Oznacenie Rozmer
. - 4
: — ) et e— RN 10x38
) i I Oznadenie Rozmer I RAPID ACCIAIO Kova hmozdinka
= S ) a .
- _ | TI5-27V 5x27 I do sadrokarténu
Oznacenie Rozmer | TI5-37V 5x37 * | -~
C10A80LUVT 10x80 * | TJ5-47V 5x47 |
C10A100LUVT 10x100 * | Tl6-32V 6x32 | Oznacenie Rozmer
C10A120LUVT 10x120* | TJ6-40V 6x40 * | RA 10x32
C10A140LUVT 10x140 * | TJ6-55V 6x55 * | BRIC BCM‘Nyi'onova hrr'zoi,dinka S
C10A160LUVT 10x160 * | T16-67V Exél | metrickym zakon&enim
C10A200LUVT 10x200 | TJ6-80V 6x80 |
| Sl S - | Oznacenie Rozmer
| TI8-60V 8x60 | BENIE 1ox72
! L 8x75°* ! BCM10 14x72
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FIXING INNOVATION

Hmozdinka/Kotva

BETA Uderova kotva $141/50 A

' 516C/5 16x110

m S16M/20 16x125

Oznacenie Rozmer Oznatenie Rozmer S16L/40 LoRL4S
oM4 5x16 B6 M6x28 S16XL/65 16x170
oms 7x22 BS M8x33 S16XLK/95 16x213
ome 8x24 B10 M10x43 S16E/115 16x220
oms 10x30 B12 M12x53 SZERLD 20x270
oM10 12x35 B16 M16x65 S201/70 20x220
i S50 $20L/135 20x270
GETO PLUS Skrutka do beténu S24C/20 24x180

DELTA Plastova kotva so 6hr skrutkou o g S241/100 24x260

SITA CE 7 Svornikova kotva s

i |
I I
I I
I I
I Oznacenie Rozmer I ¢ A2
I GP6/60 7,5x60 I , p: S :
. GP6/75 7,5x75 % i
Oznacenie Rozmer ’
DELV845 8x45 I GP8/60 10x60 I Oznaéenie Rozmer
DELV870 8x70 | GP8/75 10x75 | TTSK12200/105 12x200
DELV1055 10x55 | GP8/100 10x100 | TTSK12220/125 12x220
DELV1080 10x80 | GP8/150 10x15 | TTSK12240/145 12x240
DELV10100 10x100 | GP10/60 12x60 | TTSK12280/185 12x28
DELV10120 10x120 | GP10/75 12x75 | TTSK12300/205 12x300
DELV10140 10x140 | GP10/90 10x90 | TTSK12360/265 12x360
DELV1265 12x65 | GP10/100 12x100 | TTSK16240/125 16x240
DELV1280 12x80 | GP10/120 12x1120 | TTSK16280/165 16x280
DELV12100 12x100 | GP10/150 12x150 | TTSK16300/185 16x300
DELV12120 12x120 | SITA Svornikova kotva s prstencom A2 | TTSK15400/245 16x400
DELV12140 12x140 | W | MA GP Dvojzlozkova malta
DELV1675 16x75 | e EE | Polyester bez styrénu
DELV16110 16x110 | Oznatenie Rozmer | -
TRIALTRM Kotva do dutych stropoy | S1K640/2 GxA0 | =
: | sec/s 6x45 |
| sem/10 6x55 |
e X | sel/50 6x90 I
Oznatenie Rozmer | siKe100 6x100 | Oznacenie Objem
TRM6 M6x42 | ssc/10 8x55 | " ma410GP 410 mi
TRMS NI8X52 | ssm/20 8x75 | MA300 300 ml
50 150ml
TRM10 Mi0x60 | S8L/40 8x95 | iMA
TRM12 M12x75 | s8e/60 8x115 I T VE-SF Dvojzlozkova malta
TRM16 M16x90 | s1062/3 10x62 | Vinylester bez styrénu
| s10c/10 10x70 I \
ALFA ALM Oceloliatonova kotva | s1iom/20 10x90 |
. | s10L/30 10x100 |
W S—. i S10E/60 10x120 I
— S12M/15 12x95
Oznacenie Rozmer
e e | s126/30 12x110 | =
ALME B I S12X/40 12x120 I Oznacenie Objem
512L/80 12x160 T400VE 410 ml
AR s | s14c/5 1100 | Ta00vE 300 mi
ALM12 M12 | |
| 514M/30 14130 |
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FIXING INNOVATION

EPO PLUS RE Dvojzlozkova HFN stahovacia paska
malta cisty EPOXY material: polyamid
farba: Cierna

Oznacenie Rozmer
HFN 1025 100 x 2,5
HFN 1425 140 x 2,5
HFN 2025 200x 2,5
HFN 1436 140 x 3,6
| HFN 2036 200 x 3,6
Oznacenie Objem HEN 2936 290 x 3,6
EPO PLUS RET385 385 ml HFN 3636 360 x 3,6
EPO PLUS RE T585 585 ml HFN 2548 250x4,8
NORDIC Dvojzlozkova malta HFN 2048 200 x 4,8
mrazu odolna do -20 °C HFN 2948 290 x 4,8
HFN 3648 360x4,8
HFN 5348 530x4,8
HEN 2576 25076
HFN 3676 360x7,6
HFN 5390 530x9,0

HFB stahovacia paska
material: polyamid

3 [ >
Oznaéenie Objem farba: biela —
T400V NORDIC 400 ml Draenia e
T300V NORDIC 300 ml HFB 1025 TR
HFB 2025 200 x2,5
HFB 1436 140 x 3,6
HFB 2036 200 x 3,6
HFB 2936 290x3,6
HFB 3636 360 x 3,6
HFB 2548 250x 4,8
HFB 2048 200 x 4,8
HFB 2948 290 x 4,8
HFB 3648 360x4,8
HFB 5348 530 x 4,8
HFB 2576 250 7,6
HFB 3676 360x7,6
HFB 5390 530 x 9,0

I
I
I
|
I
I
I
I
I
I
I
|
I
I
|
|
|
|
|
I
|
|
|
I
I HFB 1425 140x2,5
I
I
I
I
I
I
|
|
I
I
|
|
|
I
|
I
I
I
|
I
I
I
I
I
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Uhholnik/Spojka

g I A B C ; LG kd A B
E | : 50 150 35 | Cmm)yer 972 30
|} 70 70 55 | G2 193 35
KP ked A B C | 150 150 35 | LG3 293 40
— | 9 9% 65 |
3 [(mm) kp1 90 90 gg | 105 105 90 |
g KP2 105 105
5 | B | -
_ KP3 90 50 55
S KP4 70 70 85 I I } WB kd A 8
N7 I 300 40 40 | (mm) WB1 25 118
0 40 38 111
KPL kd A B C | 4 40 | —
/qvmm) KPL1 90 90 65 | | 38 171
7 KPL2 105105 90 | A B | :} 110
90 50 55 | I 140
70 70 55 | 123 ;g I 41 170
| 1 200 35 | 45 108
| ZE0IEEI | 45§[ 13553
A B C | 180 65 |
210 90 51 135
40 40 17 | ] 51 165
— S .
1 (mm)pwq 50 17 60 100
CECEERI T %
755 g 58| | w3z 100 17 | =
I w4 150 17 | bl o 190
| LW5 193 20 | ——e Séo
A B C LW6 243 20
| W7 293 735 | WB20 64 128
o | L | WB21 70 126
40 40 4 | PP Kked A i | WB22 70 155
60 60 60 | (mm) pp1 80 40 | WB23 76 122
| o pP2 100 40 | WB24 76 152
| PP3 120 40 | WB25 76 182
| PP4 160 40 | wB26 80 120
ABC | PP5 140 60 | WB27 gg 153
s PP6 160 60 WB28 18
28 28 ;‘3 I o PP7 200 60 { WB29 80 210
60 60 40 | B PP8 240 60 I WB30 100 140
60 60 60 I . PP9 200 80 I wB31 100 170
60 60 80 PP10 240 80 WB32 100 200
= P11 300 80 | WB33 115 163
o5 sy @9 | PP12 200 100 | WB34 115 193
80 80 60 | PP13 240 100 | WB35 120 160
80 80 80 | PP14 260 100 | WB36 120 190
80 80 100 | PP1S 300 100 | WB37 140 180
100 100 60 | PP16 400 100 | WB38 160 170
100 100 80 | PP17 500 100 ] " 5
100 100 100 | PP18 200 120 |
40 40 100 PP19 240 120 e
Ao | PP20 260 120 | ——
| PP21 300 120 | A 70
S | PP22 400 140 | e
10075 30 | PP23 400 160 |
120 80 35 | PP24 300 200 |
180 120 40 | PP25 1200 40 |
I 1

PP26 1200 60
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Uhholnik/Spojka

510320 10 320
C510340 10 340
Ccs10360 10 360
510380 10 380
CS10400 10 400

PS ked A B C

—=(mm) psgoy 91 325 120
PS100U 101 325 120

PS120U 121 325 120

* PS140U 141 325 120

PZD kod A B

-(mm) p7D1 48 17

£

e PZD3 75 26
albod® pzDa o5 33

PSG Kod A B C

-1 (mm) psG45 46 550 100

PSG70 71 750 150

| PSG90 91 750 150
PSG100 101 900 150 .
PSG120 121 900 150 o

KLM ked A

i (mm) KLM2 250

WBZ ked A B, Konvexnyked A B | Tesarske ked A B
(mm) wezo1 70 125 | KlinieC  assao a5 40 | skrutky sCT08080 8 80
wez22 70 155 | 7 (mm)A40x40 40 40 | . CT08100 8 100
wez2s 76 122 | | AsOxd0 50 40 | Malisovanoucrogizo g 120
wBz24 76 152 | | AB0x4,0 60 4,0 | loZkou cTo8140 8 140
WBZ25 76 182 | § A75x4,0 75 40 | CT08160 8 160
() wBz26 80 120 | A100x4,0 100 40 | (mm) CT08180 8 180
o wBz27 80 150 I A125x4,0 125 4,0 I CT08200 8 200
WBZz28 80 180 | it | = CT08220 8 220
WBZ29 80 210 | Tesirskeked A B /f;gj_gg CT08240 8 240
WBZ30 100 140 I skrutky csososo 8 80 I \\\\‘:; CT08260 8 260
e G5 6 | SO C508100 § 100 | .. CT08280 8 280
W8z33 115 163 | Zapustenou €S 08120 8 120 | CT08300 8 300
; hlavou €508140 8 140 CT08320 8 320
WBZ34 115 193 | coesiEs 5 ey | — ~==
e — | (mm) cso8180 8 180 | e
WBZ36 120 190 CT08360 8 360
I £~ Cs0820 8 220 | CT08400 8 400
LK  ked A8 | @@ Cs08240 8 240 | cT10120 10 120
o 3, | Csose0 8 260 | CT10140 10 140
S | 17 (Cs0880 8 280 | CT10160 10 160
210 32 | 1 Cs0s00 8 300 | CT10180 10 180
210 32 | Cs08320 8 320 | CT 10200 10 200
250 32 | C508340 8 340 | CT10220 10 220
250 32 | 6508300, 8¢ 360 | CT10240 10 240
200 32 | cso838o0 8 380 | CT10260 10 260
290 32 | CS08400 8 400 | CT10280 10 280
| cs10120 10 120 | CT10300 10 300
A B | C510140 10 140 | g}ggig }g gig
i) C510160 10 160
- cs ot 10130 | =
q NA3 250 30 | G IR0 13 ggg |
| NA4 300 40 510220
E_ NAS 50 0 I C510240 10 240 I
NA6 60 10 I s 10260 10 260 I
NA7 75 12 €S110280 10 280
. B I C510300 10 300 I
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
| |
I |

el



Kotuce

Rezny kotuc na Nerez

Brasny kotu¢ lamelovy Oznatenie Roamer
T A46EX 115x1.6x22.23
el e A46EX 125x1.6x22.23
SMT615 40 115x22:23 - -
A60EX 115x1x22.23
SMT615 60 115x22.23 AGOEX 125x1x22.23
SMT615 80 115%x22.23 -
SMT615 40 125x22.23
SMT615 60 125%22.23

SMT615 80 125x22.23

Diamantovy kotu¢ segmentovy

Mg Oznacenie Rozmer
7 o DL60U 115x22.23
vBr_usny kotuc DL60U 125x22.23
O;n;:E;e 1 15R0(:m;2r 23 PAeal i
XOXZZ.
DL60U 230x22.23
A24EX  125x6x22.23 8
A24EX 150x6x22.23 P
A24EX 180x6x22.23 '
A24EX 230x6x22.23

Diamantovy kotuc uzavrety

Oznacenie Rozmer
=7 DS60T 115x22.23
Rezny kotu¢ univerélny DS60T 125x22.23
Oznacenie Rozmer DS60T 180x22.23
A24EX 115x2.5x22.23 DSe0T 230022:23
A24EX 125X 2.5%22:23
A24EX 150x2.5x22.23
A24EX 180x2x22.23
A24EX 180x3x22.23
A24EX 230x2x22.23
A24EX 230X3X22.23
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Oznacenie Rozmer Oznacenie Rozmer Oznacenie Rozmer

20746 4x110 mm 20764 12x160 mm 20783
20747 5x110 mm 20765 12x210 mm 20784
20748 6x110 mm 20766 12%x260 mm 20785
20749 6x160 mm 20767 12x350 mm | 20786
20750 6x210 mm 20768 12x460 mm 20787
20751 6x260 mm 20769 12x600 mm 20788
20752 8x110 mm 20770 12x1000 mm 20789
20753 8x160 mm 20771 14x160 mm 20790
20754 8x210 mm 20772 14%260 mm 20791
20755 8x260 mm 20773 14x350 mm 20792
20735 8x350 mm 20774 14x460 mm 20793
20756 10x160 mm 20775 14x600 mm 20794
20757 10x210 mm 20776 14x1000 mm 20795
20758 10x260 mm 20777 16x160 mm 20796
20759 10x350 mm 20778 16x210 mm 20797
20760 10x 450 mm 20779 16x260 mm 20798
20761 10x600 mm 20780 16x350 mm 20799
20762 10x 1000 mm 20781 16x460 mm

| |
I I
| |
I |
I I
| I
I |
I |
I I
I I
I I
I I
I I
I I
I |
I I
I I
| I
I |
| |
I I
I I
| I
I I
{ 20763 12x110 mm 20782 16x600 mm {
I I
I I
I I
| |
I I
I I
I |
| |
| |
I |
| |
I I
I I
I I
I I
I I
| |
I I
I I
I I
| |
I |
I I
I |
| |
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